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DNA 20 kb Plasmid and Linear Kit 1
The DNA 20 kb Plasmid and Linear kit supplies the reagents for sample preparation and the
methods to separate a wide range of plasmids and linearized dsDNA by size.

This document gives instructions for sample preparation with the DNA 20 kb Plasmid and
Linear kit. It also gives instructions for data acquisition with the BioPhase software and the
Waters Empower™ software with the BioPhase 8800 driver for Empower™. This document also
gives instructions for data analysis of data acquired with BioPhase software. The analysis of
data acquired with the Waters Empower™ software must be done with the Waters Empower™

software.

Use the information in this application guide as a place to start. If required, change the injection
time, voltage, injection type, or other parameters to find the best conditions for the requirements.

Note: For instructions about how to use the system safely, refer to the document: Operator
Guide.

Safety
Refer to the safety data sheets (SDSs), which are available at sciex.com/tech-regulatory,
for information about the correct handling of materials and reagents. Always follow standard
laboratory safety guidelines. For information about hazardous substances, refer to the section:
Hazardous Substance Information.

Intended Use
The DNA 20 kb Plasmid and Linear kit is for laboratory use only.

Introduction
The DNA 20 kb Plasmid and Linear kit is used to do isoform and purity analysis of plasmids
and size and purity analysis of linearized dsDNA. This kit supplies high analytical resolution
and can analyze a wide range of double-stranded nucleic acid molecules. Plasmid isoforms
from 2,000 bp to 19,000 bp can be separated, including super coiled, linear, and open circular
species. The kit can do size estimation and purity analysis for linear dsDNA samples from
100 bp to 20,000 bp.

Before the sample is injected, the conditioning method coats the capillaries. A pressure injection
sends the DNA sample into the capillary. The different species in the sample are separated
by size in a bare fused-silica (BFS) capillary filled with a replaceable polymer gel that supplies
sieving selectivity. The fluorescent labeling dye SYBR™ Gold Nucleic Acid gel stain1 is added to
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the polymer gel matrix during reagent preparation. The dye binds to DNA molecules so that the
DNA can be detected by laser-induced fluorescence (LIF) at 520 nm during the separation.

The separation can be done with a capillary cartridge with 30 cm bare fused-silica capillaries
for both plasmid isoform and linearized dsDNA samples. To increase peak efficiencies for linear
dsDNA fragments, use a capillary cartridge with 50 cm bare fused-silica capillaries.

Workflow
The workflow has the following steps:

1. Identify the number of samples to be analyzed and the number of replicates.

2. For BioPhase software users:

a. Create or change the methods. Refer to the section: Methods.

b. Create the sequence and the sample and reagent plate layouts. Refer to the section:
Create the Sequence.

3. For Waters Empower™ software users:

a. Import the BioPhase software methods. Refer to the section: Import the BioPhase
Software Methods to Create Instrument Methods.

b. Create the sample set methods and the sample and reagent plate layouts. Refer to the
section: Create the Sample Set Method.

4. Prepare the samples. Refer to the section: Prepare the Samples.

5. Use the sample and reagent plate layouts to prepare the plates. Refer to the section: Plate
Layouts.

6. Put the plates in the BioPhase 8800 system. Refer to the sections: Load the Sample Inlet
and Outlet Plates and Load the Reagent Inlet and Outlet Plates.

7. Start data acquisition.

• BioPhase software: Start the sequence from the front panel. Refer to the section: Run the
Samples.

• Waters Empower™ software: Start the sample set method from the Waters Empower™

software with the BioPhase 8800 driver for Empower™. Refer to the section: Start the
Sample Set Method.

8. After the run, stow the cartridge. Refer to the section: Stow the Cartridge After the Run

9. Analyze the data.

• BioPhase software: When the sequence is complete, use the BioPhase Analysis
software to analyze the data. Refer to the section: Analyze the Data.

1 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Gold Nucleic Acid gel stain is not available
for resale.
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• Waters Empower™ software: When the sample set method is complete, use the Waters
Empower™ software to analyze the data. For data analysis instructions, refer to the
Waters Empower™ software guides and help file.
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Required Equipment and Materials 2
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.

Table 2-1 DNA 20 kb Plasmid and Linear Kit (PN 5311708)

Component Quantity Reorder Part
Number

Acid wash/regenerating solution (100 mL) 1 5312349

CE Grade water (140 mL) 2 C48034

DNA 20 kb Plasmid and Linear conditioning solution
(135 mL)

1 53122832

DNA 20 kb Plasmid and Linear gel (135 mL) 1 53122832

DNA 20 kb Plasmid and Linear sample buffer (60 mL) 1 53122832

DNA 20 kb Plasmid test mix (8 ng in 20 µL) 6 N/A

SYBR™ Gold Nucleic Acid gel stain3 4(120 µL) 6 N/A

Table 2-2 Other Supplies from SCIEX

Component Quantity Part Number

Capillary cartridge coolant (450 mL) 1 359976

BioPhase 8800 bare fused-silica capillary cartridge
(50 µm i.d. × 30 cm capillaries)

1 5080121

BioPhase 8800 bare fused-silica capillary cartridge
(50 µm i.d. × 50 cm capillaries)

1 5080123

BioPhase 8800 outlet plates 20 5080315

BioPhase 8800 reagent plates 20 5080314

2 The DNA 20 kb Plasmid and Linear separation pack (PN 5312283) contains DNA 20 kb Plasmid and Linear
conditioning solution, DNA 20 kb Plasmid and Linear gel, and DNA 20 kb Plasmid and Linear sample buffer.
None of the parts can be ordered separately.

3 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Gold Nucleic Acid gel stain is not available
for resale.

4 The concentration of the dye is diluted approximately 100 × from the concentration of the dye available from
Thermo Fisher Scientific.
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Table 2-2 Other Supplies from SCIEX (continued)

Component Quantity Part Number

BioPhase 8800 sample plates 20 5080313

BioPhase 8800 Starter Plate Pack (4 sample plates, 4
reagent plates, 8 outlet plates)

1 5080311

Table 2-3 Other Required Reagents or Supplies

Description Vendor Part Number

(Optional) 1 Kb Plus DNA Ladder (250 µg) ThermoFisher
Scientific

10787018

X-Pierce Film USA Scientific 2997-0100

Storage Conditions
Note: For storage conditions for prepared reagents, refer to the preparation instructions.

• Upon receipt, keep the following at 15 °C to 30 °C:

• Acid wash/regenerating solution

• CE Grade water

• DNA 20 kb Plasmid and Linear sample buffer

• Upon receipt, keep the following at 2 °C to 8 °C:

• DNA 20 kb Plasmid and Linear conditioning solution

• DNA 20 kb Plasmid and Linear gel

• Upon receipt, keep the DNA 20 kb Plasmid test mix and the SYBR™ Gold Nucleic Acid gel
stain5 at –35 °C to –15 °C.

Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

• Protective eyewear

• Laboratory coat

• Analytical balance

5 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Gold Nucleic Acid gel stain is not available
for resale.

Required Equipment and Materials
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• Centrifuge with swinging-bucket rotor to hold plates

• Disposable plastic conical tubes, 50 mL (or equivalent)

• Microcentrifuge, or equivalent, and nuclease-free microcentrifuge tubes (USA Scientific PN
1615-5510)

• PCR tubes, 0.2 mL flat-cap nuclease-free (VWR USA PN 20170-012 or VWR EUR PN
732-0548)

• Pipettes and applicable tips

Note: For reagent plate preparation a repeater pipette or equivalent is recommended.

• Vortex mixer

Required Detector
An LIF detector with a 488 nm excitation source and a 520 nm emission filter is required.

Required Cartridge
CAUTION: Potential Wrong Result. If a cartridge is used with the DNA 20 kb Plasmid
and Linear kit, then do not use the same cartridge for another application. If the
same cartridge with different buffers and sample types is used, then sample carryover,
nonspecific binding, and poor separation can occur.

A BioPhase 8800 bare-fused silica capillary cartridge with 50 µm inner diameter (i.d.) × 30 cm
capillaries is required.

(Optional) To increase the resolution for linear dsDNA samples, a BioPhase 8800 bare-fused
silica capillary cartridge with 50 µm inner diameter (i.d.) × 50 cm capillaries can be used.

Refer to the table: Table 2-2.

Condition the Capillaries
CAUTION: Potential Wrong Result. Do not use a basic solution to clean the capillary.
The solution might negatively ionize the capillary wall and result in electro-osmotic
flow detrimental to the separation of nucleic acids. These interactions might cause poor
separation.

• Before a new cartridge is used, condition the capillaries with DNA 20 kb Plasmid and Linear
conditioning solution and either the 30cm-DNA 20kb Conditioning or the 50cm-DNA
20kb Conditioning method.
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Note: Do not use the conditioning method more frequently than every 30 to 50 injections.
Examine run-to-run separation metrics such as Res. (peak resolution) and N (theoretical plates)
before conditioning. If the metrics are acceptable, then conditioning is not required.

Required Equipment and Materials
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Methods and Sequences 3
Methods and Sequences for the BioPhase
Software
Note: If the validated methods and sequences are not included with the software, then they are
available for download from the SCIEX website. Refer to the section: Download and Configure
the Required Files. The methods can also be created manually with the BioPhase software.
Refer to the section: Methods.

The following methods and sequence are required.

• For a cartridge with 30 cm capillaries:

• 30cm-DNA 20kb Conditioning: Conditions the capillaries as part of a sequence, if
required.

• 30cm-DNA 20kb Linear Separation: Does the separation, best for linear dsDNA
samples and plasmids larger than 4 kb.

• 30cm-DNA 20kb Plasmid Separation: Does the separation, best for plasmid
samples.

• 30cm-DNA 20kb Shutdown: Cleans the capillaries at the end of a sequence, rinses the
capillaries for storage, and then turns off the lamp.

• 30cm-DNA 20kb Rinse: Rinses the capillary between sequences, if required.

• For a cartridge with 50 cm capillaries:

• 50cm-DNA 20kb Conditioning: Conditions the capillaries as part of a sequence, if
required.

• 50cm-DNA 20kb Linear Separation: Does the separation, best for linear dsDNA
samples that require maximum resolution.

• 50cm-DNA 20kb Shutdown: Cleans the capillaries at the end of a sequence, rinses the
capillaries for storage, and then turns off the lamp.

• 50cm-DNA 20kb Rinse: Rinses the capillary between sequences, if required.

• Sequence templates:

• 30cm-DNA 20kb Plasmid Test Mix- 6 runs with conditioning: A sequence
template for a cartridge with 30 cm capillaries.
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• 50cm-DNA 20kb DNA ladder- 6 runs with conditioning: A sequence template
for a cartridge with 50 cm capillaries.

Methods for the Waters Empower™ Software
To create the required instrument methods, import the BioPhase software methods.

Note: If the methods are not included with the software, then they are available for download
from the SCIEX website. Refer to the section: Download and Configure the Required Files
(Waters Empower™ Software). The methods can also be created manually with the Method
Editors for BioPhase System software. Refer to the section: Methods.

Create the Sequence
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure is
not applicable. Refer to the section: Create the Sample Set Method.

Note: This procedure is for users who know how to use the BioPhase software. For detailed
instructions, refer to the document: Software Help System.

This procedure gives instructions to create a sequence with a template that is supplied with the
BioPhase software.

Two templates are supplied: one for a cartridge with 30 cm capillaries and one for a cartridge
with 50 cm capillaries.

Sequences can also be created without a template. In most cases, a sequence should start
with a conditioning method, include separation methods, and then end with a shutdown method.
Usually, the shutdown method should be identified as the error recovery method. Refer to the
document: Software Help System.

Note: If the sequence includes replicate samples, then make that sure the replicates are in the
same row of the sample plate to decrease any capillary-to-capillary variation.

1. On the Home page of the BioPhase software, click Sequence Editor.

2. Click Open Sequence.
The Open a Sequence dialog opens.

3. Search for, and then select a sequence:

a. (Optional) Type a Start Date and End Date for the search, or click the calendar icons,
select the dates, and then click Search.
The available project folders are shown in the Folder Name pane.

b. Click the DNA 20kb project folder.
The available sequences in the project are shown in the table to the right.

Methods and Sequences
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c. In the table, click the sequence template, and then click Open.

• For 30 cm capillaries, click 30cm-DNA 20kb Plasmid Test Mix- 6 runs
with conditioning.

• For 50 cm capillaries, click 50cm-DNA 20kb DNA ladder- 6 runs with
conditioning.

The Open a Sequence dialog closes, and then the Sequence Summary tab opens.

4. Above the Sequence Summary pane, click Edit.
The Sample Plate Setup tab opens.

5. If required, then do any of the following actions:

• Add or remove samples.

• Clear a method that is assigned to a sample well.

• Assign a different method to a sample well.

• In the Sequence Summary table, assign the recovery method to a method in the
sequence. Usually, the shutdown method should be identified as the recovery method.

For detailed instructions, refer to the document: Software Help System.

6. If required, edit the information in the Sequence Summary table.

Note: The method names are different for each sequence.

Figure 3-1 Sequence Summary Table: 30cm-DNA 20kb Plasmid Test Mix- 6
runs with conditioning

7. To see details of a run, click the + in the row with the run.
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Figure 3-2 Sequence Summary Table Expanded

8. If required, change the information in the Sample Id and Data File columns.

9. To see the sample plate and reagent plate layouts, open the Plates Layout tab. If required,
change the reagent locations in the Reagent Plate pane.

10. To save the sequence, click SAVE, and then add the required information.

Note: If errors occurred, then the SAVE button is not available. Correct all of the errors in
the Validation pane, and then click SAVE.

11. (Optional) To print the sample plate and reagent plate layouts, do the following:

a. Click PRINT.
The Print Preview dialog opens.

b. Click Plate Layout Report, and then click Print.

c. Select the printing options, and then click OK.
The report is printed.

d. Close the Print Preview dialog.

Methods and Sequences
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Prepare the Samples 4
Best Practices for Work with DNA
Note: CE Grade water is not certified as nuclease-free. DNA 20 kb Plasmid and Linear sample
buffer is made from nuclease-free components but is not certified as nuclease-free.

Tips for DNA Samples
To avoid contamination and degradation, handle DNA samples with care.

• Use ice to keep the sample cool.

• Work in a nuclease-free environment.

• Wear gloves at all times.

• Use sterile, filtered pipette tips.

• Avoid repeated freeze-thaw cycles.

• Lower the speed of the vortex mixer.

• Set the centrifuge to use gentle acceleration and braking profiles.

Tips to Optimize the Signal
DNA concentration is most important parameter to optimize for accurate quantification. For
plasmid analysis, the optimal range for DNA concentration depends on the quantity of the
open circular isoforms in the sample. Use the lowest concentration range where all isoforms
of interest have a signal-to-noise ratio >10. In this assay, open circular isoforms are detected
at a concentration of approximately 0.30 ng/μL. For example, if the expected open circular
isoform percent corrected peak area (% CPA) is approximately 30%, then the total plasmid DNA
concentration should be no more than 1.0 ng/μL to keep the signal of all isoforms in the linear
range.

Linearized and relaxed open circular (nicked) DNA isoforms have a higher affinity for dye than
the supercoiled isoform. If the supercoiled isoform is expected, then start with a 250× dilution of
SYBR™ Gold Nucleic Acid gel stain in the gel buffer. This is the dye concentration used by the
procedure given in this guide. To optimize signal between all isoforms, more titration of the dye
concentration may be required.

For samples that contain only linearized dsDNA, the recommended concentration range is
greater than the recommended concentration range for plasmid DNA isoforms. To detect all
peaks of interest, adjust the sample concentration to make sure that all linearized peaks have
concentrations greater than the limit of quantitation (LOQ).

Prepare the Samples
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The gel stain concentration has a large effect on peak migration time. A higher concentration of
dye increases migration time and a lower concentration decreases migration time. The volume
specified in this application guide is suitable for most samples.

Prepare the DNA Ladder
The 1 Kb Plus DNA Ladder6 can be used as a test sample for the analysis of linearized
double-stranded DNA (dsDNA). It can also be used to create a calibration curve for analysis of
linearized dsDNA.

Note: For a test sample for plasmid isoform analysis, use the DNA 20 kb Plasmid test mix. Refer
to the section: Prepare a Test Sample for Plasmid Isoform Analysis.

1. Thaw the 1 Kb Plus DNA Ladder6 on ice.

2. To make enough for eight samples (one column in the sample tray), add 5 μL of 1 Kb Plus
DNA Ladder6 (500 ng/μL) to 800 μL of DNA 20 kb Plasmid and Linear sample buffer, and
then mix with a vortex mixer.

3. Add between 95 μL and 100 μL to the sample plate well.

4. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 1.5 mL of CE Grade water.

Prepare a Test Sample for Plasmid Isoform
Analysis
To help identify issues with the BioPhase 8800 system or reagent preparation, run the DNA
20 kb Plasmid test mix before doing the analysis of new samples. The test mix is made from
DNA that is 5.4 kb in length and contains the three main plasmid isoforms: supercoiled, linear,
and open circular forms.

Note: For a test sample for linearized DNA, use the 1 Kb Plus DNA Ladder6. Refer to the
section: Prepare the DNA Ladder.

1. Thaw a vial of DNA 20 kb Plasmid test mix on ice.

2. To make enough for eight samples (one column in the sample tray), add 800 μL of DNA
20 kb Plasmid and Linear sample buffer to the vial of DNA 20 kb Plasmid test mix, and then
mix with a vortex mixer.
After dilution, the final DNA concentration of the DNA 20 kb Plasmid test mix is
approximately 1 ng/µL.

3. Add between 95 μL and 100 μL to the sample plate well.

6 1 Kb Plus DNA Ladder (Invitrogen™) is available for purchase from ThermoFisherScientific.

Prepare the Samples
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4. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 1.5 mL of CE Grade water.

5. Keep the solution that is not used at –35 °C to –15 °C for a maximum of 3 months.

6. Put the sample plate in the system.

7. Make sure that the plate compartment temperature is set to 10 °C.

Prepare a Plasmid DNA Sample
1. Thaw the DNA on ice.

2. Measure the total DNA concentration of sample using UV absorbance or fuorescence
spectrometer.

3. Prepare the sample in DNA 20 kb Plasmid and Linear sample buffer at a concentration
between 0.5 ng/μL and 5 ng/μL, depending on the abundance of open circular isoform in the
sample.
To get the most reproducible results, the higher the concentration of open circular isoform
in the sample, the lower the total DNA concentration should be. Refer to the section:Tips to
Optimize the Signal.

4. Add between 95 μL and 100 μL to the sample plate well.

5. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 1.5 mL of CE Grade water.

6. Put the sample plate in the system.

7. Make sure that the plate compartment temperature is set to 10 °C.

Prepare a Linearized dsDNA Sample
If the sample contains only of linearized dsDNA, then the recommended concentration range is
wider than when analyzing plasmid DNA isoforms. It is crucial to use a sample concentration in
which all linear peaks of interest meet the limit of quantitation (LOQ).

1. Thaw the DNA on ice.
Keep the sample cool to help prevent degradation of the DNA.

2. Use the table below to find the recommended DNA concentration, and then prepare the
DNA sample in DNA 20 kb Plasmid and Linear sample buffer.

Table 4-1 Recommended DNA Concentrations

DNA Sample Recommended
Concentration (ng/μL)

Purified single-peak DNA 0.1

DNA ladder 0.5 to 1.0

Prepare the Samples
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Table 4-1 Recommended DNA Concentrations (continued)

DNA Sample Recommended
Concentration (ng/μL)

Linearized DNA digest 0.5 to 1.0

3. Add between 95 μL and 100 μL to the sample plate well.

4. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 1.5 mL of CE Grade water.

5. Put the sample plate in the system.

6. Make sure that the plate compartment temperature is set to 10 °C.

Prepare the Samples
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Prepare the BioPhase 8800 System 5
Use the procedures in this section to prepare the BioPhase 8800 system to acquire data.

Tip! To save time, turn on the light source 30 minutes before the start of the run to let it become
warm.

Load the Reagent Inlet and Outlet Plates
Note: The gel buffer and dye mixture is referred to as gel buffer in this document.

CAUTION: Potential Wrong Result. Do not prepare the gel buffer before it is required.
Degradation of the SYBR™ Gold Nucleic Acid gel stain in the gel buffer might occur
during storage and cause peaks with decreased intensity.

Note: To prevent air bubbles, do not shake or vigorously mix the gel buffer. Air bubbles might
cause issues with the separation.

Note: Only X-Pierce film from USA Scientific has been validated for use. If a different film is
used, then test it before use.

CAUTION: Potential System Damage. Do not use a heated plate sealer to attach the
film cover. If the heat causes damage to the surface of the plates, then issues with the
pressure system might occur.

CAUTION: Potential Wrong Result. Before the plates are loaded in the system, spin them
to remove air bubbles. Air bubbles might an unsatisfactory separation.

CAUTION: Potential System Damage. Before the plates are loaded in the system, remove
the film cover. Do not load plates in the system before the film cover is removed. If the
film cover is not removed, then damage to the capillary tips might occur.

1. Add the following reagents to a conical tube.

Note: For replicate injections, make sure to adjust the volume accordingly.
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Table 5-1 Gel Buffer (DNA 20 kb Plasmid and Linear gel with SYBR™ Gold Nucleic
Acid gel stain)

Reagent For 1 to 96 Samples or
12 Injections

DNA 20 kb Plasmid and Linear gel 20 mL

SYBR™ Gold Nucleic Acid gel stain7 80 μL8

Tip! Wrap the tube that contains the prepared gel buffer in aluminum foil to decrease
photobleaching of the SYBR™ Gold Nucleic Acid gel stain.

2. Carefully invert the tube a minimum of 20 times.
Make sure that air bubbles are not created when the tube is inverted.

3. Use the reagent plate layout to add the following reagents to the reagent inlet and outlet
plates. Refer to the figure: Figure C-4.

Table 5-2 Reagents for the Reagent Inlet and Outlet Plates

Plate Reagent

Inlet plate 800 µL per well

Outlet plate • 2.8 mL of reagent per well for separation or wait positions

• 1.5 mL of CE Grade water per well for waste positions

Note: For the outlet plate, make sure that the chamfered corner is on the top right, and then
fill only the wells on the left side of the plate. The wells on the right side are for overflow and
must be empty.

4. Put a film cover on the plates.

5. Put the plates in a swinging-bucket rotor, and then spin them for 4 minutes at 30 × g. Make
sure that the buckets are balanced.

6. Make sure that there are no air bubbles in the plates. To remove air bubbles, then spin the
plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 × g. For the sample plate, the maximum
RCF is 375 × g.

7. On the front panel, touch Eject Reagent.

7 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Gold Nucleic Acid gel stain is not available
for resale.

8 The structure of the DNA has an effect on the volume of dye required. Refer to the section: Best Practices for
Work with DNA.
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Figure 5-1 Eject Reagent Button

The plate compartment opens.

8. Remove the film cover from the plates.

9. If the plate compartment contains reagent plates, then remove them.

10. Align the notch in the reagent inlet plate with the tab, and then put the plate in the plate
carrier.

11. Make sure that the chamfered corner of the reagent outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

12. Touch Load Reagent.

Figure 5-2 Load Reagent Button

The plate compartment closes.

Load the Sample Inlet and Outlet Plates
CAUTION: Potential System Damage. Do not use a heated plate sealer to attach the
film cover. If the heat causes damage to the surface of the plates, then issues with the
pressure system might occur.

Note: Only X-Pierce film from USA Scientific has been validated for use. If a different film is
used, then test it before use.

1. Use the sample plate layout to add the samples to the sample inlet plate. Refer to the figure:
Figure C-3.
The recommended sample volume is 100 µL. The minimum sample volume is 50 µL. The
maximum sample volume is 200 µL.

2. Use the sample plate layout to add the following reagents to the sample outlet plate. Refer
to the figure: Figure C-3.
The maximum volume is 2.0 mL.
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Note: For the outlet plate, make sure that the chamfered corner is on the top right, and then
fill only the wells on the left side of the plate. The wells on the right side are for overflow and
must be empty.

Table 5-3 Reagents for the Sample Outlet Plate

Plate Reagent

Outlet plate • 1.5 mL of CE Grade water per well

3. Make sure that, for any column on the sample plate with sample, the related column on the
outlet plate has 1.5 mL of CE Grade water.

4. Put a film cover on the plates.

5. Put the plates in a swinging-bucket rotor, and then spin them for 4 minutes at 30 × g. Make
sure that the buckets are balanced.

6. Make sure that there are no air bubbles in the plates. To remove air bubbles, then spin the
plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 × g. For the sample plate, the maximum
RCF is 375 × g.

7. On the front panel, touch Eject Sample.

Figure 5-3 Eject Sample Button

The plate compartment opens.

8. Remove the film cover from the plates.

9. If the plate compartment already contains sample plates, then remove the sample plates.

10. Align the notch in the sample plate with the tab, and then put the plate in the plate carrier.

11. Make sure that the chamfered corner of the sample outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

12. Touch Load Sample.
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Figure 5-4 Load Sample Button

The plate compartment closes.

Examine the Capillary Cartridge
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.

CAUTION: Potential System Damage. Do not let the gel buffer or other reagents
crystallize on the electrodes, capillary tips, cartridge seals, or cartridge body. Electrolyte
salt crystals or precipitate can cause blocked capillaries, improper pressure seals, errors
when samples are injected, arcing, or current leakage.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol or
acetone, to clean the capillary window. Organic solvents can dissolve the adhesives and
make a residue on the capillary window that causes interference with the detector.

1. Examine the electrodes, capillary tips, cartridge seals, and cartridge body before use.

2. If gel or liquid has collected on the outside of the cartridge, then clean the cartridge with a
moist lint-free wipe. After cleaning, make sure to dry the cartridge.

Note: Do not use soap or detergent to clean the cartridge.

3. If the capillary tips are blocked, then do this:

a. Use CE Grade water to clean the outside surface of the capillary inlets.

b. Use a lint-free wipe to clean the capillary inlets carefully in an outward direction.

4. Use a magnifying glass to examine both sides of the capillary window. If lint or other
particles have collected, then use short bursts of electronics-grade compressed air to
remove them. Do not use water or other liquids to clean the capillary window.

5. Dampen a lint-free wipe or cotton swab with ethanol or isopropanol, and then clean the
surface of the ID chip. Let the ID chip air-dry before the cartridge is installed.

Install the Capillary Cartridge
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.
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WARNING! Pinching Hazard. When the front panel is opened, do not put fingers to
the left of the front panel.

CAUTION: Potential System Damage. Make sure that the reagent plates are installed in
the system before the cartridge is installed. Otherwise, damage to the cartridge might
occur.

1. If the cartridge was kept in the refrigerator, then let the cartridge equilibrate to ambient
temperature for approximately 30 minutes to prevent condensation in the system.

2. Remove the cartridge from the wetting tray.

3. To prevent arcing, use a disposable laboratory wipe to dry the cartridge body to prevent
arcing.

4. Turn the bottom of the cartridge up.

5. Use a disposable laboratory wipe to very carefully dry the area where the capillaries and
electrodes come out of the cartridge. Do not touch or move the seals.

Figure 5-5 Bottom of the Cartridge
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Item Description

1 Outlet plate seal

2 Inlet plate seal

6. If the reagent plates are not installed in the system, then install them. Refer to the section:
Load the Reagent Inlet and Outlet Plates.

7. Open the front panel, and then put the cartridge in the system.

8. Close the front panel, and then touch EJECTED to lock the cartridge.

Figure 5-6 EJECTED Button

The system moves the reagent plate until the capillaries are in position over column 1, and
then lifts the plate until the capillary tips are immersed in CE Grade water.

9. Examine the coolant level on the front panel. If required, add coolant to the system.
Refer to the section: "Add Capillary Cartridge Coolant" in the document: Operator Guide.
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Run the Samples 6
Tips for Best Results
Use the Rinse Method
A rinse method is supplied with the other methods for the kit.

After the capillary has been conditioned, use the applicable rinse method as an alternative to the
conditioning method. If the cartridge has done more than 50 injections since it was conditioned,
then examine run-to-run separation metrics such as Res. (peak resolution) and N (theoretical
plates). If the metrics are acceptable, then conditioning is not required. Use the rinse method in
the sequence. If the quality of the separation has decreased, then use the conditioning method
in the sequence.

Start the Sequence from the Front Panel
To use the Waters Empower™ software, refer to the section: Start the Sample Set Method.

1. If required, load the cartridge, reagent plates, and sample plates.

2. On the front panel, touch RUN SEQUENCE.

Figure 6-1 RUN SEQUENCE Button

3. In the Projects pane, touch DNA 20kb.

4. In the Available Sequences pane, touch the applicable sequence in the list.

• For a cartridge with 30 cm capillaries, click 30cm-DNA 20kb Plasmid Test Mix- 6
runs with conditioning

• For a cartridge with 50 cm capillaries, click 50cm-DNA 20kb DNA ladder- 6 runs
with conditioning

5. (Optional) To see the details of the method, sample plates, or reagent plates, touch
anywhere in the Method column.
To hide the details, touch the column or box again.

Run the Samples
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6. Touch Run Sequence.

Figure 6-2 Run Sequence Button

If the sequence contains a method that is incompatible with the system configuration, then
Run Sequence is not available.

The data files are saved at the location specified in the sequence. If this location has a data
file with the same name, then, to prevent the older data file from being overwritten, a date
stamp is automatically added to the file name.

If an error occurs during a run and an error recovery method is included in the sequence,
then the BioPhase 8800 system starts the error recovery method.

During the run, various actions are available. Refer to the section: Monitor the Run on the
BioPhase 8800 Front Panel.

When the run is complete, the Run Completed dialog opens.

Figure 6-3 Run Completed Dialog

7. To close the Run Completed dialog, touch OK.

8. If required, stow the cartridge. Refer to the section: Stow the Cartridge After the Run.

Monitor the Run on the BioPhase 8800 Front
Panel
CAUTION: Potential System Damage. If the run is stopped, then sample or reagent might
be lost and damage to the cartridge might occur.

CAUTION: Potential System Damage. If the run is stopped and will not be started again,
then use the shutdown method to rinse the capillaries before the cartridge is stowed. If
the capillaries are not rinsed, then electrolyte salt crystals or precipitate can collect and
might cause blocked capillaries, incorrect pressure seals, errors when the samples are
injected, arcing, or current leakage.
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CAUTION: Potential System Damage. Before the run is started again, make sure to empty
or replace the outlet plate to prevent the overflow of reagent and possible damage to the
instrument.

CAUTION: Potential Wrong Result. Before the run is started again, prepare new reagent
plates. If the run has been stopped, then there might not be sufficient reagents available
to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, sample degradation might have occurred. Discard the samples
before the run is started again.

Use this procedure to monitor the sequence progress, and then, if required, pause or stop the
sequence.

To use the Waters Empower™ software, refer to the section: Monitor the Run in the Waters
Empower™ Software.

Note: The sequence shown in the following figures is for the purpose of illustration. It does not
show a sequence for the DNA 20 kb Plasmid and Linear kit.

1. Monitor the traces for the detector and the current to make sure that the sequence is in
progress.

2. To stop the run, touch .

Figure 6-4 Warning Dialog

3. Touch one of the following options:

• Yes: To start the error recovery method, if one is assigned.

• No: If an error recovery method is not assigned.

Run the Samples

DNA 20 kb Plasmid and Linear Kit For the BioPhase
8800 System
30/89

Application Guide
RUO-IDV-05-15737-A



• Cancel: To continue the run.

4. If an error occurs, then touch OK in the error dialog that opens.

Figure 6-5 Run Sequence Error Dialog

Note: The  shows an error at the Rinse action. The grey shading in the row above the
Rinse action shows that the action is in progress or completed.

5. Review the error:
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a. On the Events tab of the front panel log, touch 

b. Touch Initialize System to initialize the system and change the system status to idle.

Figure 6-6 Sequence Error Events Log

6. If required, then touch Pause Run.
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Figure 6-7 Run Sequence in Progress

To continue the run, touch Cancel Pause.
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Figure 6-8 Run Sequence Paused

7. To see the data during acquisition, touch  in the ribbon.

Note: The data in the following figure is for illustration only. It does not show results for
samples prepared with the DNA 20 kb Plasmid and Linear kit.
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Figure 6-9 Capillary View

8. (Optional) To zoom in on the data, do the following:

a. Touch Overlay.

b. Use two fingers to zoom in or out to see the electropherogram.

c. Use the hand icon to move the electropherogram.

Note: The zoom feature can only be used with the Overlay view for Detector and
Current.

Run the Samples

Application Guide
RUO-IDV-05-15737-A

DNA 20 kb Plasmid and Linear Kit For the BioPhase
8800 System

35/89



Figure 6-10 Zoom In or Out

9. Make sure that the message Sequence run Completed Successfully is shown when
the run completes. In the dialog, touch OK.

Figure 6-11 Run Completed Dialog
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If the system has been idle for 24 hours, then the cooler for the sample storage
compartment turns off.

Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Obey local directives
to discard chemicals, cartridges, reagent plates, sample plates, and the
remains of the prepared samples. They might contain regulated compounds
and biohazardous agents.

Stow the Cartridge After the Run
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.

Stow the Cartridge for Less than 24 Hours
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillaries.
The shutdown method fills the capillaries with CE Grade water and decreases the cartridge
temperature to 20 °C.

2. Keep the cartridge in the system for as long as 24 hours with the capillary tips immersed in
CE Grade water.

Note: If the cartridge has not been used for 3 hours or longer, then run the conditioning
method before a separation is done.

Stow the Cartridge for More than 24 Hours
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillaries.
The shutdown method fills the capillaries with CE Grade water and decreases the cartridge
temperature to 20 °C.

2. On the ribbon on the BioPhase 8800 system front panel, touch  (Loaded), and
then wait for approximately 1 minute to let the coolant go back to the coolant reservoir
before the cartridge is removed.

3. Remove the cartridge from the system. Stow the cartridge upright in the cartridge box at
2 °C to 8 °C with the capillary tips immersed in CE Grade water.

Note: Replace the CE Grade water in the tray regularly to prevent microbial growth in the
tray.
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Note: Make sure that there is sufficient CE Grade water in the tray to immerse the capillary
tips.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, and has done fewer than 50 injections

since it was conditioned, then use the applicable rinse method to rinse the capillaries.

• If the cartridge has not been used for more than a day, and has done more than 50 injections
since it was conditioned, then examine run-to-run separation metrics such as Res. (peak
resolution) and N (theoretical plates). If the metrics are acceptable, then conditioning is not
required. Use the rinse method to prepare the cartridge. If the quality of the separation has
decreased, then prepare the cartridge with the applicable conditioning method.

Note: To prevent arcing, and before the cartridge is installed in the system, carefully remove any
water from around the electrodes and cartridge body.

Run the Samples
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Analyze the Data 7
Use an Analysis Parameters File to Analyze the
Data
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure is
not applicable.

An analysis parameters file contains all of the information required to integrate the data and then
identify peaks.

Note: This procedure is for users who know how to use the BioPhase software. For detailed
instructions, refer to the document: Software Help System.

Note: The analysis parameters file in this procedure is an example. The parameters might not
be optimal for all data files.

1. On the Home page of the BioPhase software, click Data Analysis.
The BioPhase Analysis software main window opens.

2. Click File > Open, select the data files to analyze, and then click Open.

3. On the Project toolbar, click , browse to the analysis parameters files, and then click
Open.
Three analysis parameters files are available. Click the applicable file:

• 30 cm_Plasmid test mix analysis example: Analyze the plasmid test mix for
data acquired with the 30 cm capillaries.

• 30 cm_1kb plus ladder integration example: Analyze the 1 Kb Plus DNA
Ladder for data acquired with the 30 cm capillaries.

• 50cm_1kb plus ladder integration example: Analyze the 1 Kb Plus DNA
Ladder for data acquired with the 50 cm capillaries.

4. Right-click , and then select Apply & Analyze (all).

The software applies all of the parameters on the Integration, Library, and Post Analysis
tabs to all of the data files, and then shows the results.

In the Files pane, the file name is red to show that the data has been analyzed. The number
of peaks identified is shown in the Peaks column.
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In the Data pane, the analysis results are shown in the table below the graph. At the top
of the table, RMS Noise, P-P Noise, and Drift are shown. In the graph, the baseline is red
and the threshold is a grey horizontal line. Any peaks identified in the analysis have a blue
marker at the peak start, a red marker at the peal apex, and a green marker at the peak
end.

Peaks in the graph have the following shading:

• Green: The peak is identified as a peak in the Marker Table on the Library tab.

• Blue: The peak is identified as a peak in the Peak Table on the Library tab.

• Red: The peak is not a named peak.

Refer to the section: Examine the Results.

5. Show the peak names on the graph:

a. Right-click .
The Information Setup dialog opens.

b. Select Name and any other information to include on the graph, such as MT, and then
click OK.

c. Click .

The peak names are shown on the graph. Refer to the section: Examine the Results.

The names are part of the analysis parameters file. To use different names, refer to the
section "Identify the Peaks" in the document: Software Help System.

6. Click in the Files pane below the list of files, and then press the Up and Down arrow keys to
see the data for each file in the Data pane.
If required, drag over a region on the graph to zoom in to see the details of the identified
peaks in that region.

Tip! To use the same zoom settings to all of the data files, click .

7. Make sure that the integration is satisfactory. If required, then adjust the integration
parameters, and then analyze the data again.

8. Examine the electropherogram for the peaks in the Marker Table and Peak Table.

a. For each peak in the Marker Table and Peak Table, make sure that the correct peak has
a label in the graph.

b. If required, adjust MT in the Marker Table and MT (or Cal MT) in the Peak Table.

c. If required, adjust Tol and Crit, and then click .
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• Tol is the tolerance used to find a match between a peak in the graph and a peak
in the Marker Table or the Peak Table. To use the tolerance as a percentage, type %
after the value.

• Crit is the peak characteristic used to find a match.

• Ctr: The peak closest to the center of the range is used to find a match.

• Ht: The tallest peak in the range is used to find a match.

• Area: The largest peak in the range is used to find a match.

d. When the peak assignments are satisfactory, right-click , and then select Apply &
Analyze (all).

The software applies the changes to all of the data files.

9. (Optional) On the Project toolbar, click , type a name, select a location, and then click
OK.
The analysis parameters are saved to a file for later use.

10. (Optional) On the File toolbar, right-click , and then select Print (all).
The contents of the Data pane are printed in the active report template. For instructions to
create a report template, refer to the section "Configure a Report" in the document: Operator
Guide.

11. On the File toolbar, right-click , and then select Save (all).
All changes to the results are saved to the data files. The analysis parameters are included.

12. On the File toolbar, right-click , and then select Close (all).
All of the data files close.
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Examine the Results
Figure 7-1 DNA 20 kb Plasmid test mix with 30 cm Capillaries

Figure 7-2 1 Kb Plus DNA Ladder with 30 cm Capillaries
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Figure 7-3 1 Kb Plus DNA Ladder with 50 cm Capillaries

Review the Results on the Overlay Tab
The Overlay tab shows the graphs for the selected data files. This tab has statistics for the
selected data files, as well as the system suitability report.

Note: This section does not describe the system suitability function. For information about
system suitability, refer to the document: Operator Guide.

1. Open a set of data files and the analysis parameters file, and then analyze the data. If
required, adjust the analysis parameters until the results are satisfactory.

2. In the Files pane, click , and then open the Overlay tab.
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Figure 7-4 Overlay Tab

The color of the trace in the graph corresponds to the color in the circle next to the file name
in the Files pane.

The thicker line is the trace for the file selected in the Files pane.

3. To change the order of the files in the overlay, in the Files pane, click the file to be moved,
and then drag it up or down the list of files.

Note: The order of the colors assigned to the files does not change after a file is moved.

4. To adjust the distance between the traces, move the slider on the right side of the graph up
or down.

Note: To see the traces as a series of tiled graphs, move the slider all of the way to the top.
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Figure 7-5 Tiled Results
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5. Calculate the results for all of the files on the Overlay tab.

Figure 7-6 Results Table

Item Description

1 Reference file

2 Type of analysis

3 Save the results to a comma-separated file

a. To select the type of analysis, click the list on the right side of the Results Table header.

These options are available:

• Reference - All: In the Results Table, show statistics for every peak in the reference
file that is in all of the other data files.

• Reference - Peak Table: In the Results Table, show statistics for every named peak
in the reference file that is in all of the other data files.

• Named Peaks: In the Results Table, show statistics for all of the named peaks in the
data files.

• All Data (not displayed): Calculate but do not show statistics for all of the peaks in
all of the data files.

• System Suitability: System suitability testing is different than the other reports. For
more information, refer to the section "System Suitability Testing" in the documents:
Operator Guide or Software Help System.

If the migration times of the peak apexes in the data file are within 5% of the peak
apexes in the reference file, then a match is made.

b. To select the reference file, click the list on the left.

The reference file is the file to which all of the other files are compared.
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Only the Reference - All and Reference - Peak Table analyses use a reference file.

The Results Table changes to show the selected analysis or the system suitability report.

If All Data (not displayed) is selected, then the Results Table is empty. To see the results,
click Save to save the results to a comma-separated file, and then use another program to
open the file.

6. (Optional) To use a different reference file or see a different type of analysis, do step 5
again.

7. (Optional) Click Save.
The Results Table is saved to a comma-separated text file. Only the columns that are shown
in the table are saved.

Note: To save the system suitability results, click File > Save Report. The results are saved
as a PDF.

8. (Optional) Click File > Print.
The contents of the Overlay tab are printed in the current report template.

9. (Optional) On the File toolbar, right-click , and then select Save (all).
All changes to the results and the analysis parameters are saved to the data files.

10. On the File toolbar, right-click , and then select Close (all).
All of the data files close.

Guidance for Acceptance Criteria
To create acceptance criteria for use with this kit for SOPs or other purposes, use parameters
that are inherent to the quality of the separation and attributes that show critical sample qualities.
Differences between gel and capillary lots and different systems might cause variations in
absolute migration times.

For plasmid isoform analysis, the ratio of the migration time of the linear isoform to the migration
time of the supercoiled isoform can be used a system suitability criterion. The resolution
between the peaks for the supercoiled and linear isoforms can also be used. Do not use percent
corrected peak area because it can vary from lot to lot of the DNA 20 kb Plasmid test mix.

For linearized dsDNA analysis, if the 1kb plus DNA ladder is present, then the migration time
ratio between 1.5 kb and 0.1 kb peaks (or any combination of spaced peaks) for relative
migration time. Resolution between resolved peaks can also be used.

SCIEX strongly discourages the use of absolute migration time as an acceptance criterion for
either type of analysis.
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Run the Samples with the Waters
Empower™ Software 8
This section gives instructions for the use of the Waters Empower™ software and the BioPhase
8800 driver for Empower™ with the BioPhase 8800 system.

Import the BioPhase Software Methods to Create
Instrument Methods
Note: Methods created with the BioPhase software are supplied with the BioPhase 8800 driver
for Empower™. The methods are also available for download from the SCIEX website. Refer to
the section: Download and Configure the Required Files (Waters Empower™ Software).

Instrument methods can also be created in the Method Editors for BioPhase System software.
Refer to the documents: Operator Guide and Software Help System.

Typically, three types of methods are required: a conditioning method, separation method, and
shutdown method. For some workflows, there are more methods.

The following methods are available.

• For 30 cm capillaries:

• 30cm-DNA 20kb Conditioning: Conditions the capillaries before first use.

• 30cm-DNA 20kb Linear Separation: Does the separation, best for linear dsDNA
samples and plasmids larger than 4 kb.

• 30cm-DNA 20kb Plasmid Separation: Does the separation, best for plasmid
samples.

• 30cm-DNA 20kb Shutdown: Cleans the capillaries at the end of a sequence, rinses the
capillaries for storage, and then turns off the lamp.

• 30cm-DNA 20kb Rinse: Rinses the capillary between sequences, if required.

• For 50 cm capillaries:

• 50cm-DNA 20kb Conditioning: Conditions the capillaries before first use.

• 50cm-DNA 20kb Linear Separation: Does the separation with more resolution.

• 50cm-DNA 20kb Shutdown: Cleans the capillaries at the end of a sequence, rinses the
capillaries for storage, and then turns off the lamp.

• 50cm-DNA 20kb Rinse: Rinses the capillary between sequences, if required.
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1. In the Waters Empower™ Software Project window, click File > New Method > Instrument
Method.

Figure 8-1 Select Desired Chromatography System Dialog

2. Click the name of system to be used, and then click OK.

The Instrument Method Editor opens.

3. Click Import, and then browse to the conditioning method.
The method opens in the Instrument Method Editor with the Method Settings tab in front.

Note: The Instrument Method Editor window is read-only. If changes to the method are
required, then save the instrument method, and then edit the method in the Method Editors
for BioPhase System software. Refer to the section: "Edit an Existing Instrument Method" in
the document: Software Help.
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Figure 8-2 Instrument Method Editor: Method Settings

4. (Optional) To see the actions, open the Method Program tab.

5. To see the parameters for an action, click the row in the table.
The Parameters pane changes to show the parameters.

Figure 8-3 Instrument Method Editor: Method Program
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6. Save the conditioning instrument method:

a. Click File > Save with Method Set.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Some versions of
the Waters Empower™ software accept more than 30 characters and other special
characters. If the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Method Comments field, type the information.

d. If a prompt is shown, then in the Password field, type the Waters Empower™ software
password for the current user, and then click Save.

The instrument method and method set are saved to the current project.

7. Click File > Exit.

Note: After a method has been imported, the Import button in the Instrument Method Editor
is not available unless the window is closed and then opened again.

8. To create the other instrument methods and method sets, repeat steps 3 through 7.

Create the Sample Set Method
Note: A sample set method requires method sets. Make sure that any required instrument
method is part of a method set.

The following instructions create a sample set method for eight samples (the number of wells in
one column in a sample plate).

1. In the Waters Empower™ Software Run Samples window, click BioPhase 8800 > BioPhase
Sample Set Editor.

The Method Editors for BioPhase System software opens, to the Sample Set Method Editor
workspace.

2. Click New Sample Set Method.
The Sample Set Method Editor opens to the Sample Plate Setup tab.

3. In first row of the Sample Set Summary table, click the Method Set Name cell, and then
select the applicable conditioning method set.

4. In the Sample Plate Layout pane, click 1.
The first column in the sample plate is selected and the Sample Set Summary table
changes to show the selected wells.
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Figure 8-4 Sample Plate Layout Pane

5. In the Sample Set Summary table add the required sample information. In row 2 through
row 9, do the following:

a. In the Sample Name cell, type a name.

b. Click the Method Set Name cell, and then select the applicable separation method set.

Tip! After the method set is selected for row 2, right-click and select Apply method to
all samples in column to assign the method set to all of the samples.

6. In the last row, click the Method Set Name cell, and then select the applicable shutdown
method set.
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Figure 8-5 Sample Set Summary Table

7. If the Validation pane is shown, then click the pane to see the errors. Click an error to
identify where it occurs, and then make the required change.
If there are no errors, then the Validation pane is not shown.

8. Save the sample set method:

a. Click SAVE AS.

Note: If errors occurred, then the SAVE AS button is not available. Correct all of the
errors in the Validation pane, and then click SAVE AS.

The Save Sample Set dialog opens.

b. In the Sample Set Name field, type a name.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Some versions of
the Waters Empower™ software accept more than 30 characters and other special
characters. If the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Description field, type information.

d. Click Save.

e. To acknowledge the saved method, click OK.

The sample set method is saved to the Waters Empower™ software database.

9. To see, save, or print the plate layouts:

a. Open the Plate Layouts tab.

Run the Samples with the Waters Empower™ Software

Application Guide
RUO-IDV-05-15737-A

DNA 20 kb Plasmid and Linear Kit For the BioPhase
8800 System

53/89



b. (Optional) Click PRINT.
The Print Preview window opens.

c. If required, click the applicable button to print or save the plate layouts.
Refer to the section: "Print Preview Dialog" in the document: Software Help System.

d. Close the Print Preview dialog.

10. Close the Method Editors for BioPhase System software.
The Run Samples window is shown.

Start the Sample Set Method
1. Load the cartridge and plates. Refer to the section: Prepare the BioPhase 8800 System.

2. In the Waters Empower™ software Project window, click Tools > Run Samples.

Figure 8-6 Select Desired Chromatography System Dialog

3. Click the name of the system to be used, and then click OK.
The Run Samples window opens.

4. Configure the plate type:

a. Click Edit > Plates.
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Figure 8-7 Define Plates for Sample Set Method Dialog

Note: If the dialog does not look like the preceding figure, then clear the 2790 Layout
check box.

b. Click the Plate Type Name cell, and then select ANSI-96well2mL.
The dialog changes with an image of the plate and buttons for the plate sequencing
mode.

c. Click the Plate Layout Position cell, and then type 1.

d. To set the order of access for the wells during the run, click .

e. To save the changes, click OK.

f. Close the dialog.

Tip! To permanently configure the plate type, click Customize > Defaults, click Plates. In
the Define Plates For Sample Set Method dialog, do steps 4.b through 4.e, and then, in the
Run Samples Defaults dialog, click OK.

In the Sample Set Method table, the heading for the Vials column changes to Plate/Well.

5. Click  (Load Sample Set).
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Figure 8-8 Load Samples Dialog

6. Click Load using a previously created sample set method, and then click OK.

Figure 8-9 Open an existing sample set method Dialog

7. Click DNA 20kb Kit Sample Set Method, and then click Open.
The sample set method opens in the Samples tab.

8. (Optional) Configure the table to show only the columns that are relevant for the BioPhase
8800 system:
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a. Right-click, and then select Table Properties.
The Table Properties dialog opens.

b. Click Hide All, and then clear the Plate/Well, # of Injs, SampleName, Function, and
Method Set / Report or Export Method check boxes.

c. Click OK.

The table changes to show the selected columns.

Figure 8-10 Samples Tab

9. Review the sample set method. Make sure that the correct reagent plate layout was used.
If changes are required, then edit the method in the Method Editors for BioPhase System
software. Changes to the instrument methods or method sets are automatically transmitted
to the sample set method.

10. In the Waters Empower™ Software Project window, click  (Start).
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Figure 8-11 Run Sample Set Dialog

11. If required, edit the information:

a. If required, edit the Name for this sample set field.

b. (Optional) Click Shutdown Method, and then select the rinse instrument method that
was created previously.
If the system encounters an error during a run, then it executes this instrument method,
and then stops the run.

c. If required, select Do Not Run Shutdown Method During User Abort.

d. Click Run.

The run starts. During the run, in the Sample Set Method window, the text in the row for the
sample being acquired is red.

CAUTION: Potential Data Loss. During a run, do not start any actions from the
BioPhase 8800 driver for Empower™ Direct Control pane, even if the system status
is idle. Any actions that are started might cause interference with data acquisition.
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Monitor the Run in the Waters Empower™

Software
CAUTION: Potential Data Loss. Do not stop the run until all of the data is saved. The data
is saved when the sample set method is on the next row.

CAUTION: Potential System Damage. If the run is stopped and will not be started again,
then use the shutdown method to rinse the capillaries before the cartridge is stowed. If
the capillaries are not rinsed, then electrolyte salt crystals or precipitate can collect and
might cause blocked capillaries, incorrect pressure seals, errors when the samples are
injected, arcing, or current leakage.

CAUTION: Potential System Damage. Before the run is started again, make sure to empty
or replace the outlet plate to prevent the overflow of reagent and possible damage to the
instrument.

CAUTION: Potential Wrong Result. Before the run is started again, prepare new reagent
plates. If the run has been stopped, then there might not be sufficient reagents available
to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, sample degradation might have occurred. Discard the samples
before the run is started again.

Use this procedure to monitor the progress of the sample set method, and then, if required, stop
or pause the sample set method.

Note: Most of the panes in the Waters Empower™ software are made for chromatography. Use
the following steps to monitor the progress of the capillary electrophoresis separation and ignore
the information in the Time Remaining and Solvent Required panes.

1. To stop the run, click  (Abort).

Note: Do not use the Stop button in the Direct Control pane. That button is only applicable
to functions that are started from the Direct Control pane.
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Figure 8-12 Abort Options Dialog

When the run ends, the text in all of the rows in the Sample Set Method window is red.

2. To see the data during acquisition, in the Direct Control pane, click  (Monitor).

Figure 8-13 Trace View Window
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3. If required, do any of the following:

• To see current, voltage, or pressure, open the applicable tab in the top left.

• To see one graph with the data for all of the capillaries, in the bottom left, click Overlay.

• To see data for some of the capillaries, select or clear the check boxes at the bottom of
the window for the capillaries of interest.

• To see the time and detector values for any point on a trace, click the trace at the position
of interest.

• To zoom in on the data, make sure that Overlay is selected, and then drag to select the
area to zoom. The mouse scroll wheel can also be used to zoom.

• To go back to the original data dimensions, in the bottom right, click Reset Zoom.

• To see a different area of a zoomed plot, right-click the X- or Y-axis, and then drag.

4. If required, at the bottom right, right-click Auto Zero.
The detector signal is set to zero.

5. Wait until  (Abort) changes to  (Start).
A delay between data acquisition and when all of the data is saved might occur. The green
button identifies that all of the data is saved.

6. If required, discard the samples and reagents. Refer to the section: Waste Disposal.

7. If required, stow the cartridge. Refer to the section: Stow the Cartridge After the Run.
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Troubleshooting 9
After each corrective action is complete, we recommend that the analysis be done again to
make sure that the symptom has been corrected.

Symptom Possible Cause Corrective Action

Cartridge not
detected error

1. The ID chip on the cartridge is
not clean.

2. The contact pins on the
system are not clean.

3. The BioPhase 8800 system
firmware is not up to date.

1. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
clean the surface of the ID chip.
Let the ID chip air-dry before the
cartridge is installed.

2. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
clean the contact pins. Let the
pins air-dry before the cartridge
is installed.

3. Do the following:

a. On the BioPhase 8800
system front panel, touch
the icon in the top left
corner.

b. Record the firmware
version.

c. Contact sciex.com/request-
support.

Error found at start
of run

1. When the optics door was
opened and closed, a sensor
error occurred.

1. Turn off, and then turn on the
BioPhase 8800 system.

To prevent this from occurring
again, always use the applicable
procedure to change the filters.
Refer to the sections: "Install
a UV Filter" and "Install the
Filters for the LIF Detector" in
the document: Operator Guide.
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Symptom Possible Cause Corrective Action

Broad peaks, poor
resolution

1. The capillary tip is damaged.

2. The sample concentration is
too high.

3. The capillary is blocked.

4. The internal surface of the
capillary is contaminated.

5. The capillary coating is
damaged.

1. Do the following actions:

• Use a magnifying lens to
examine the capillary tip.

• Use a lint-free wipe to clean
the capillary inlets carefully in
an outward direction.

• Make sure that the capillary
tip extends approximately
2 mm from the gold cannula
electrode.

• Make sure that the capillary
tip has a straight cut and is
not broken. If the capillary
cannot be used, then refer
to the section: Options for
a Blocked or Damaged
Capillary.

2. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

3. Refer to the section: Options
for a Blocked or Damaged
Capillary.

4. Edit the sequence to omit
the contaminated capillary or
replace the cartridge.

5. Condition the capillary.
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Symptom Possible Cause Corrective Action

Broad peaks,
poor resolution
(continued)

1. The cartridge is no longer
serviceable.

2. The capillary cartridge was
kept at ambient temperature
for more than a week.

1. Do a test separation of a
linearized dsDNA ladder. If the
peak widths are consistently
wider than previous runs, then
replace the cartridge.

2. Replace the cartridge.

Carryover 1. The sample concentration is
too high.

2. The reagent plate is
contaminated with sample.

1. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

2. In the separation method, add
one or more water dip steps
after sample injection. With the
edited method, do the following
steps:

a. Create a new sequence
that uses this separation
method.

b. Prepare new reagent plates
for the new sequence.
Refer to the section: Load
the Reagent Inlet and
Outlet Plates.
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Symptom Possible Cause Corrective Action

Extra peaks 1. Non-nucleic acid components
of the sample interacted with
the dye.

2. The plasticware used during
sample preparation or the
sample plate is contaminated
with materials that interact
with the dye.

3. Light scattering caused by
particulates larger than 1 μm
in the gel buffer occurred.

1. Prepare the sample again.
Make sure that it is pure.

2. Use clean plasticware and a
clean sample plate to prepare
the sample again.

3. Before the gel buffer is added
to the reagent plates, put
the sample through a syringe
filter with a 0.45 μm pore-size
membrane.

High current 1. The gel buffer is
contaminated.

2. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

1. Prepare the inlet and outlet
reagent plates again to replace
the gel buffer.

2. Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then use the plate
layout to prepare the plates
again. Refer to the section:
Plate Layouts.

Troubleshooting

Application Guide
RUO-IDV-05-15737-A

DNA 20 kb Plasmid and Linear Kit For the BioPhase
8800 System

65/89



Symptom Possible Cause Corrective Action

Low signal 1. The capillary tip is dirty or
plugged.

2. The sample volume is too low.

3. The initial nucleic acid
concentration is too low.

4. Degradation of the nucleic
acids in the sample
occurred because of sample
preparation or exposure to
nucleases.

1. Rinse the capillary. Refer to
the section: Remove Blockage
from a Capillary. Do a blank
separation run to equilibrate the
capillary surface.

2. Make sure that there is a
minimum of 50 µL of sample in
the sample well.

3. Do one or all of the following:

• Increase the Duration up
to 15 seconds in the Inject
action in the separation
method to inject more
sample. If the results are not
satisfactory, then increase
the Pressure or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.

4. Prepare the sample again.
Make sure that the sample is
not exposed to nucleases.

Low current 1. The capillary is blocked.

2. The position of the gel buffer
in the reagent plate does not
agree with the sequence.

1. Refer to the section: Remove
Blockage from a Capillary.

2. Make sure that the position of
the gel buffer during the voltage
separation step is correct. If the
positions are not correct, then
use the plate layout to prepare
the plates again. Refer to the
section: Load the Reagent Inlet
and Outlet Plates.
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Symptom Possible Cause Corrective Action

Low or unsteady
current

1. The capillary tip is blocked or
contaminated.

2. The gel buffer has air
bubbles.

1. Refer to the section: Remove
Blockage from a Capillary. If the
current is low or unsteady, then
replace the cartridge.

2. Do one or all of the following:

• Use a centrifuge to spin the
plate at 30 × g for 5 minutes
to remove air bubbles.

• De-gas the gel buffer with
5 inches Hg to 15 inches Hg
vacuum for 5 minutes.

Troubleshooting

Application Guide
RUO-IDV-05-15737-A

DNA 20 kb Plasmid and Linear Kit For the BioPhase
8800 System

67/89



Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. The electrode is broken or
bent.

3. The capillary tip is blocked or
contaminated.

4. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

5. A capillary is filled with air
bubbles.

1. Refer to the section: Options
for a Blocked or Damaged
Capillary.

2. Replace the cartridge.

3. Refer to the section: Remove
Blockage from a Capillary.

4. Make sure that the positions
of the samples and reagents
in the plates agree with the
plate layouts. If the positions are
not correct, then use the plate
layout to prepare the plates
again. Refer to the section:
Plate Layouts.

5. Do one or all of the following:

• Make sure that the wells
of the sample and reagent
plates contain sufficient
solution.

• Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then use the
plate layout to prepare the
plates again. Refer to the
section: Plate Layouts.

• Use a centrifuge to spin the
plate at 30 × g for 5 minutes
to remove air bubbles.

Slower migration
time, with or
without concurrent
low current

1. The capillary tip is blocked or
contaminated.

1. Refer to the section: Remove
Blockage from a Capillary.
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Symptom Possible Cause Corrective Action

Unstable baseline 1. The concentration of dye in
the inlet reagent plate is not
the same as the concentration
in the outlet reagent plate.

1. Prepare sufficient gel buffer for
both the inlet and outlet reagent
plates.

Corr. Area% for
the open circular
isoform is lower
than expected

1. The concentration of the
open circular isoform relative
to the total plasmid DNA
concentration is too high and
the signal is saturated.

1. Do a serial dilution of the
sample to find a concentration
range which provides stable
isoform ratios (SC:L:OC) and a
linearly decreasing open circular
corrected peak area relative to
the amount of sample dilution.

Peaks for the
supercoiled plasmid
isoform are split

1. For shorter plasmids (< 3 kb),
interactions between the
plasmid, the labeling dye,
and the gel buffer result in
split peaks for the supercoiled
isoform.

1. Use the 30cm-DNA 20kb
Plasmid Separation method
which has a 20 kV injection. If
the results are not satisfactory,
then increase the injection
voltage to a maximum of 30 kV.

Low signal-to-noise
ratio

1. The sample concentration is
too low.

1. Do the following:

a. Increase the sample
concentration but not so
much that the signal of
the open circular isoform is
saturated.

b. If the results are not
satisfactory, then increase
PMT Gain from 10 to 100.

Supercoiled and
linear isoforms are
more abundant than
expected relative to
the open circular
isoform

1. The total DNA concentration
is too high and the signal for
the open circular isoform is
saturated.

1. Dilute the DNA sample so that
the concentration of the open
circular isoform is 0.30 ng/µL or
less.

For linear double-
stranded DNA the
peak resolution is
less than expected

1. The linearized dsDNA species
are too similar in size to
be resolved with the 30 cm
cartridge.

1. Use the 50 cm cartridge and the
applicable methods.
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Symptom Possible Cause Corrective Action

Poor resolution 1. The tips of the capillary are
dry.

2. The internal surface of the
capillary is contaminated.

3. The capillary coating is
damaged.

1. To restore the capillary surface,
use the 30cm-DNA 20kb
Rinse method or the 30cm-
DNA 20kb Conditioning
method.

2. To restore the capillary surface,
use the 30cm-DNA 20kb
Rinse method or the 30cm-
DNA 20kb Conditioning
method.

3. Condition the capillary.

Remove Blockage from a Capillary
1. Rinse the capillary with CE Grade water at 75 psi for 10 minutes.

2. Use CE Grade water to clean the outside surface of the capillary inlets.

3. Use a lint-free wipe to clean the capillary inlets carefully in an outward direction.

4. If the blockage cannot be removed, then edit the sequence to ignore the damaged capillary,
or replace the cartridge.

Options for a Blocked or Damaged Capillary
If blockage in a capillary cannot be removed or a capillary is damaged, then edit the sequence to
omit the blocked or damaged capillary. Refer to the section: Create the Sequence.
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Hazardous Substance Information A
The following information must be noted and the related safety measures must be obeyed. For
more information, refer to the related safety data sheets. The safety data sheets are available on
request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

Acid wash/regenerating solution

DANGER! Causes severe skin burns and eye damage.

DNA 20 kb Plasmid and Linear conditioning solution

DANGER! May damage fertility or the unborn child.

Other Reagents

• CE Grade water

• DNA 20 kb Plasmid and Linear gel

• DNA 20 kb Plasmid and Linear sample buffer

• DNA 20 kb Plasmid test mix

• SYBR™ Gold Nucleic Acid gel stain9

For reagents from other vendors, read the safety data sheet from the vendor before use.

9 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Gold Nucleic Acid gel stain is not available
for resale.
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Download Required Files B
Do the procedure for the software in use:

• BioPhase software: Refer to the section: Download and Configure the Required Files.

• Waters Empower™ software: Refer to the section: Download and Configure the Required
Files (Waters Empower™ Software).

Download and Configure the Required Files
Files with methods, sequences, reagents, and analysis parameters for the DNA 20 kb Plasmid
and Linear kit are available at sciex.com. Use the following instructions to download, extract, and
then copy the files to the applicable location.

Note: The following procedure is only required when BioPhase software 1.1 is used. The
required files for the DNA 20 kb Plasmid and Linear kit are included as part of the BioPhase
software 1.2 or later.

1. Go to sciex.com/software-downloads. In the More software downloads section, click
BioPhase Resources.

2. Click BioPhase Project Files 1.4.

3. In File Explorer, right-click the BioPhase 1.X.zip file, and then click Extract All.

4. Browse to a location, click Select Folder, and then click Extract.
The extracted files are copied to the selected file path.

5. Move the extracted files to the correct locations:

Note: The following instructions use the default location C:\Biophase for the BioPhase
software files. If the project folders are in a different location, then put the extracted files in
that location.

a. Drag the BioPhase 1.X\Projects\DNA 20kb folder to the
C:\BioPhase\Projects folder.

b. Drag the BioPhase 1.X\Reagents\DNA 20kb folder to the
C:\BioPhase\Reagents folder.

c. Drag the BioPhase 1.X\Data Analysis\DNA 20kb folder to the
C:\BioPhase\Data Analysis folder.

Download Required Files
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Download and Configure the Required Files
(Waters Empower™ Software)
Files for the DNA 20 kb Plasmid and Linear kit are available on sciex.com. Use the following
instructions to download, extract, and then copy the files to the applicable location.

1. Go to sciex.com/software-downloads. In the More software downloads section, click
BioPhase Driver Resources.

2. Click BioPhase Method Files 1.4.

3. In File Explorer, right-click the BioPhase-Empower-Method-Files-1.4.zip file, and
then click Extract All.

4. Browse to the location to save the method files, click Select Folder, and then click Extract.
The files are extracted and then copied to the specified location.

Download Required Files
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Reagents, Plate Layouts, and
Methods C
Reagent Set
If the reagents are not available, then use the following figures to create a new reagent set.

Figure C-1 DNA 20 kb Plasmid and Linear Kit Inlet Reagents

Figure C-2 DNA 20 kb Plasmid and Linear Kit Outlet Reagents

Reagents, Plate Layouts, and Methods
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Plate Layouts
Note: The following figures show the plate layouts for the sequence supplied with the software.
If more samples have been added or the reagent positions have been changed, then the
following layouts are not correct.

Sample Plates

Note: The top row shows the layout for the sample outlet plate. The bottom section shows the
layout for the sample inlet plate.

Figure C-3 Layouts for the Sample Inlet Plate and Sample Outlet Plate
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Reagent Plates

Note: The top row shows the layout for the reagent outlet plate. The bottom section shows the
layout for the reagent inlet plate.

Figure C-4 Layouts for the Reagent Inlet Plate and Reagent Outlet Plate
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Methods
For instructions to create a method, refer to the document: Software Help System.

Conditioning Method for 30 cm Capillaries
Figure C-5 Method Settings for the Conditioning Method for 30 cm Capillaries

Figure C-6 Actions in the Program Pane for the Conditioning Method for 30 cm Capillaries
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Figure C-7 Summary of Actions in the Conditioning Method for 30 cm Capillaries

Linear dsDNA Separation Method for 30 cm Capillaries
Figure C-8 Method Settings for the Linear dsDNA Separation Method for 30 cm Capillaries
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Figure C-9 Actions in the Program Pane for the Linear dsDNA Separation Method for 30
cm Capillaries

Figure C-10 Summary of Actions in the Linear dsDNA Separation Method for 30 cm
Capillaries
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Plasmid DNA Separation Method for 30 cm Capillaries
Figure C-11 Method Settings for the Plasmid DNA Separation Method for 30 cm
Capillaries

Figure C-12 Actions in the Program Pane for the Plasmid DNA Separation Method for
30 cm Capillaries
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Figure C-13 Summary of Actions in the Plasmid DNA Separation Method for 30 cm
Capillaries

Shutdown Method for 30 cm Capillaries
Figure C-14 Method Settings for the Shutdown Method for 30 cm Capillaries
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Figure C-15 Actions in the Program Pane for the Shutdown Method for 30 cm Capillaries

Figure C-16 Summary of Actions in the Shutdown Method for 30 cm Capillaries

Capillary Rinse Method for 30 cm Capillaries
Figure C-17 Method Settings for the Capillary Rinse Method for 30 cm Capillaries

Figure C-18 Actions in the Capillary Rinse Method for 30 cm Capillaries
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Figure C-19 Summary of Actions in the Capillary Rinse Method for 30 cm Capillaries

Conditioning Method for 50 cm Capillaries
Figure C-20 Method Settings for the Conditioning Method for 50 cm Capillaries

Figure C-21 Actions in the Program Pane for the Conditioning Method for 50 cm
Capillaries
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Figure C-22 Summary of Actions in the Conditioning Method for 50 cm Capillaries

Linear dsDNA Separation Method for 50 cm Capillaries
Figure C-23 Method Settings for the Linear dsDNA Separation Method for 50 cm
Capillaries
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Figure C-24 Actions in the Program Pane for the Linear dsDNA Separation Method for 50
cm Capillaries

Figure C-25 Summary of Actions in the Linear dsDNA Separation Method for 50 cm
Capillaries
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Shutdown Method for 50 cm Capillaries
Figure C-26 Method Settings for the Shutdown Method for 50 cm Capillaries

Figure C-27 Actions in the Program Pane for the Shutdown Method for 50 cm Capillaries

Figure C-28 Summary of Actions in the Shutdown Method for 50 cm Capillaries
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Capillary Rinse Method for 50 cm Capillaries
Figure C-29 Method Settings for the Capillary Rinse Method for 50 cm Capillaries

Figure C-30 Actions in the Program Pane for the Capillary Rinse Method for 50 cm
Capillaries

Figure C-31 Summary of Actions in the Capillary Rinse Method for 50 cm Capillaries
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Contact Us

Customer Training
• Global: sciex.com/contact-us

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, Canada, United Kingdom, Belgium, Netherlands, France,
Germany, and Switzerland have access to the online store, but access will be extended to other
countries in the future. For customers in other countries, contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives have a global staff of fully-trained service and technical
specialists. They can supply answers to questions about the system or any technical issues
that might occur. For more information, go to the SCIEX website at sciex.com or use one of the
following links to contact us.

• sciex.com/contact-us

• sciex.com/request-support

Cybersecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supersedes all of the previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

Contact Us
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To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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